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Hints

Next year’s target is the 2007 figure plus 3 — the figure in cell D22. You
should Absolutely address this cell in the formula (press [F4] or type the
$ symbols before each coordinate in the cell address).

Conditional Formatting

Select the cell range that you wish to set criteria for, e.g. B3:G14
Choose Conditional Formatting... from the Format menu.

Set up the condition required — in this example you are looking for cells
where the value is less than 80% of the average intake (the value in
cell D20).

Conditional Formatting @

Condition 1
[ EEENEN ~ | | less than v | J=$D$2EI*BEI%

Preview of Format to use AaBhCoYyFz

when condition is true:

[ add>> ] [pelte.. | [_ok | [ cancel |

Click Format... and specify the formatting required, then click OK to
close the Formatting dialog box.
Click OK to close the Conditional Formatting dialog box.

Lookup functions
You should be able to use VLookup, HLookup and perhaps Lookup
(depending on the version of software you are using).

To

extract the number of students enrolled in 2006 for NC Office

Administration possible solutions could be:

Or

=LOOKUP(2006,A3:A14,F3:F14)
This means locate the value 2006 in the range of cells A3:A14, and
then return the value in the same row from the range of cells F3:F14

=VLOOKUP(2006,A3:G14,6)

This means locate the value 2006 in column A, and then, from the cell
range A3:G14, go vertically down column 6 (the NC Administration
column) and return the value from column 6 that is in the same row as
2006.
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Spreadsheet — Full Time Statistics

Evidence Marks Comments

Comment added to cell Al 1 Comment must be displayed or
printed to get the mark.

A Lookup function must be used 2 Lookup or VLookup could be used for

to extract student numbers. this. The VLookup function would

Either VLookup or Lookup should follow one of the following formats,

be acceptable. where the year number or cell
address is specified as the Lookup
value.

=VLOOKUP(2001,A3:G14,5)
=VLOOKUP({A13,A3:G14,6)

Average function used 1

Correct cell range identified in 1 B3:G14

Average function

Average figure displayed as a 1

whole number

Conditional formatting used to 1 Any formatting acceptable, e.g.

highlight cells different font size, cell fill, etc.

Correct formula used to identify 1 =$D$21*80% (cell address should be

cells to be conditionally formatted whatever cell contains the average
function).

2008 row shows target figures 1 e.g. =B14+$D$22

which have been calculated using No mark if formula not given.

an appropriate formula Absolute addressing must be used for
D22.

Worksheet formatted effectively 2 Font size, bold, italic, shading,
borders, etc. could be used.
Maximum of 2 marks.

Print-out of data and of formulas 2

Print-outs displayed legibly on 1 No mark if reference not displayed.

page(s)

Total marks 14 marks
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Hints

The data to be charted, i.e. course titles and data, are not in adjacent cells.
Be very careful when selecting your data for charting — there should be no
Series 1, Series 2, Series 3!

Spreadsheet — Chart

Evidence Marks Comments

Column chart showing 2005— 1 2-D or 3-D column chart acceptable.

2007 data

Legend shows years 1 No mark for Series 1, Series 2, Series 3, etc.

Axes have appropriate labels 1 Both axes should have a label.

Chart has suitable title 1

Title and data series formatted 1 Mark given as long as evidence of formatting
is apparent.

Chart printed 1 Reference should be somewhere on print-
out, e.g. header/footer.

Total marks 6

Leckie & Leckie Higher Administration Course Notes
Suggested solutions to Practice task set 3, Lockwood’s Business College




Email 2

1-8

Table of Contents

Range of Courses 3

Enrolment Data. 3

Full time 1

Future Dl

Student Sucecess Storie

Gemma Fatterson

lan Borthwick.

Lockwood’'s Business College

Sumari Hussain

Annual Repor‘t 2007 Mext Year's Calendar

£ B 2 B B B B

LBCAyour intials F] 2TI0GSZ007

Rarge of Courses

The range of conrses o red B year conth ted T epand. New conrser
Ncickel tie Getting Started 4t Collsge shortsunmer conrses amed at tie
rospectte stk VBt dkd ot it meet e satrance equiEmest

The conrzes ran b6 Weeks cuer e mamEr perkel, 5 bor eack oy
They Wohiled W erasy Sklls, Bask: T Skl
<Kk, Mana e vour The andl Masaglvg Vot Fi
contses, WHE 12 stk 1B on eack. OTthoee stickat 22 stk v contiiaed
o b il e conrses Wi 1 ik ear, and e rmalir at ik 03y

Full ti me enrol mants

Woie conties. The cottses wil 10h Sjan 56 S UNMET - NGMENE art S .
AN APON BT v | caminivaton & Hie HHe Adminiviration & e e
B nlhg conrses were anotie 1 dekopme nt wi pmgmmes e hg otk ed Lkt Butingss | computing .F:gw:,?" AdMINISTATEN | oM Pty
on A Taesclay and ThIzday evenlig Mot & P - 530 pm. Thece Wer ay ay
v itk foce aleaty o wal o el fose planahi el fe
Sy Workl ¥ couiet wbrs parhary i mmegmmls ot 1936 2 i @ 12 o s
salecibed. Maneti aid gen fal De: hess Sls were also popa . e 1597 8 0 5 1z 7] 2
willexpand onT prouksion be xteal b erease fhe 1 ke orstcle b we can
cope W, 2ncl 3k d athe  conres. 1998 ) S 30 16 0 3
1999 17 24 EE 22 22 19
Enrolrnent Data
2000 12 12 7 16 0 5
ENrolne 1T Far e \ea1 were qule ieaty - e NC I Admlktaton course
Vol [ 1glest ke 1 RceNtiean. The HND In Amnhktato aid T 20m Eal 3 # 9 il #
COMIe D remalh b0 20 - 3 T Matian Bt bar bee ) COME LR ITORT e 2002 I % T Y T I
it byeaws. The HINC clsses ate al vy healthy Wil WEkes It eucess of
=g 2003 ™ Ed E ] % )
However, It b essental tiatthese fyures conthe © lcease aid te figet 2004 35 ) 26 21 19 Hl
B MItEAL K b horase of3 SR 1T 0b all N Ine conries.
2005 42 an 38 0 6 1
The At I the [t wiears & Sammarked b e 00 below.
2008 38 32 v 4 22 6
2007 ki £ 32 22 20 28

TEC RNt Wfiak

TE TNt WAk TR

Leckie & Leckie Higher Administration Course Notes
Suggested solutions to Practice task set 3, Lockwood’s Business College



was knocked out (iterally, unforunately). His opponent went on to win the Future Developments
champinzhip — and lan has since recovered fully.
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Qur congratulations go to lan. mutu ! bepeftof e lossl populahor\ busineeses andhe college itself.
Sumari Hussain New developments indude courses in: -
Sumari (HNC Business 2004) suscesstully launched The Yirtusl Secretary = ‘Web Design using Dreamuwaaver
Business last year. With her b partners, she is offering e-business and e- - Misreseft Projest
services to the UK and Europe. The Lo
buslness has groun rapidly, and she mqpms an increase in the werkfarce Project Management
 the nest few months — and has in touch wih us to see if we hawe any : ) ;
These will be offered as short courses which anyone can book in t —
poss bl sandcaies. An swing s - e dons Sman s parners! afthough they 2m aimed and priced 3t business clients in parbcular. They il
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Jury TR ummer Seho ol starks Seottish Esecuve. Gemma paszed her HMD in Administraion and
ugust 15th ummer Seho of ends Infomm ation Technolagy in 2004, nith 2 of her 30 cedits at e it lews]
On leaving sollege she wodted with a local legal firn for a vear, before going
to Brussels as an Administrative Assistant for a year, Gemma studied Frensh
and Geman throughout her HNE and is fluent in both — skills whi oh were very
important for her Brussels job and her new post.
Gemma starts at the Scotish Execufive in the summer. ‘e all send her our
congratulations and wish her eve ry sucoess in her new challenge.
Ian Borthvi ok
lan completed his HNG Business with us in 2005, He was always a keen
sportsman, and has receny retumed from the Word Karate Championships
uihere he represented 5 cotiand. He progressed to the semi finals, where he
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Hints

Watermark — Format, Background, Printed Watermark.

To remove conditional formatting in Word, set the fill option for the table
cells to No Fill.

To change the format of a bullet point, choose Bullets and Numbering from
the Format menu.

To specify a different header and/or footer for page one of a document,
display the Page Setup dialog box and then select the Layout tab. Select
the Different First Page checkbox in the Header and Footer area.

Border on header of footer area — use the Borders tool on the Formatting
toolbar.

Table of Contents — Insert, Reference, Index and Tables.

Section breaks

f

At the end of page 2, Insert, Break, Next Page. This will insert a section
break at the end of page 2 and move the insertion point to the top of
page 3.

On page 3, Insert, Break, Next Page. This will insert a section break at
the end of page 2 and move the insertion point to the top of page 4.

If you move from page 2 to 3 to 4 and watch the Section indicator (left
edge of Status bar, next to Page
indicator) you will notice the Sec value | Page 4 Jec 2 He |
changing. Sec 2 should be formatted to

landscape, and the data should be copied onto this page.

Eventually, once you have added your table of contents, Sec 2 will be
on page 4 of your document.
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Styles
To modify a style:

1 Display the Styles and Formatting task

4

pane — click = at the left of the

Formatting toolbar.

2 Click the drop-down arrow to the right of

the style name and select Modify.

3 Set the formatting options required for the

style.
4 Click OK.

Heading 1 v

Select All 1 Instance(s)

| Madify. .. |

IUpdate ko Match Selection

Word Processing — Annual Report

Evidence Marks Comments

Suitable watermark on pages 1 Should say Draft or similar.

Title page containing first 2 lines, 1

formatted effectively

College logo on page 1 1

Styles 2

- Normal style is Arial, size 12

- Heading 1 style, Arial, size 14

and bold

- Heading 2 style, Arial, size 13

and bold

Heading 1 and 2 applied to 1 No marks if any missed out.

appropriate headings

Consistent spacing throughout 1 Title page may be formatted as you

report and paragraphs justified wish.

Full Time Enrolment data copied 1 1996-2007 only.

from spreadsheet

Conditional formatting removed 1

Table presented landscape on 2 Document should be in 3 sections,

page 3 landscape page in section 2.

Font size for table set to 12 1

Column widths adjusted, etc. 1 Table fits reasonably well on page.

Bullet points added 1 Bullets should be square.

Next Year's Calendar tidied up 2 Calendar should be in 2 columns.

Page numbering, reference and 2 Must be in footer, with different first

today’s date on all pages except page option selected.

page 1

Footer information positioned 1 Tabs need to be moved to facilitate

correctly this on landscape page.

Footer has a top border 1 This must be present in all sections.

Table of contents on page 2 1

Report printed 1 Reference must be somewhere on
report to get mark — possibly
header/footer.

Total marks 22
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Course Title

CountOfStudent (D
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MC Comp Cormputing
HMC Comp HMC Computing
HMC Bus DR 2 HMNC Business
HMC Bus DR 1 HMNC Business
HMC Bus HMC Business
HMC Comp DR 1 | HMC Camputing

Record: (M)A 9 » [M]r#

HRHC AIT DR 1 HMC Administration and Infarmation Technology
HMC AIT HMC Administration and Infarmation Technaology

af 9

e B S R R R S N [y R

Hint

Aggregate query — display the Totals row in the Query design — Group by
Course Code/Course Title and Count the Student ID.

Database — Aggregate query

Evidence Marks Comments

Query contains Course Code, Course 2

Title and Student ID (or other field for

calculation purposes)

Grouped by Course Code/Course Title 1

Count function used on StudentlD field 1 No mark if Sum, Average, etc. used.
Could also have counted a different
field, e.g. a field from student data
table.

Data in descending order on Count field 1

Query result printed 1 Reference must be somewhere in
result, e.g. Query Name, and all data
clearly displayed.

Total marks 6 marks
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Report for Student Welfare Services a“

Mode of Attendance Day Release

Course Code HNC AIT DR Cowmrse Tifle  FANC Administration and hiformation Technology

Surmame First Name Student ID Title  Address Town FPostcode Telephone No E-muall

Adamson . arire 28 Mz A0 Green Paisey P24 EBPF D141 377 2746 kanneZG@auista.net
Adamzon Lucy 9 Mizz 145 E dinburh R oad Durdermiing K3 2PP 013832200 Iucyelignyehon. oo Lk
Ardamzon Paul 3 i 10 Lowdsnd Cresoernt Galazhiels TO 7@ 01896 222 331 acamannpiEyehoo.oo Lk
Braun Ekire 30 Mrs 25E ast Bank Roadd Edirknrigh EH14 2Z 0131 558 9998 ebraun@blueyvorder.co Uk
Flemirng Jefiey 20 My 1 0= Lau stonWest Paigey PAAATT 041 553 7722 Jj_fleming@drcinnet
Godddand Jack ar Mr 37 Wiendorth Loan Paigtey Po4 oLa 0141 B7F7 3992 J_ooddard@yahoo ook
Sartas SuEarne i Miss 25E ast Bank Roadd Edlirbaurgh EH14 2Z 0131 556 5999 saantas@vingin.net

Conrse Codle  HNC Buz DR Conrse Tifle  HNC Business

Sumame First Name Student ID Title  Address Town Postcode Telephone No E-mail
Buorthuck Susan 4 Mizz 37 Bryce Loan Stirling FK& 3TT 01786223 445 susarbi@hotmailco ok
Thomas Gemma B Mizs 22 Bridye Lare Galashiels TD1 SRR 01836 333 201 gemima thomas@yahoo.oo Uk

Course Code HNC Bus DR Course Title  HNC Business

Sumame First Name Stident ID Title  Address Town Postcode Telephone No E-mail
Collire Wicky & Miz=s 43a St Peter's Loan Edlirburgh EHA 7 0131 333 5522 veolins@htinternet co.uk
Douglaz Craig 21 g Haystacks Famn Nr Galsstielz  TD1 BRS 01596 334 201 craigEhlueyonder oo Uk

27 August 2007 EBCryour initials Page 1 of 3

Database — Report for Student Welfare Services

Evidence Marks Comments
Report in landscape orientation 1
All student contact details on report 1 All data must be clearly visible.
Mode of attendance, course code and 1
course title on report
Information presented grouped by 1
mode of attendance
Course code and title on one row 1 Under Mode of Attendance.
Student data sorted into ascending 2 2 sort fields — 1 mark.
order on surname and then first name Both in ascending order — 1 mark.
College logo in report header 1
All data clearly visible 1 No marks if all data not displayed.
Report has suitable title 1
Page breaks in sensible place 1
Page 1 of report printed 1 Reference must be on print-out.
Total marks 12

| Total marks for Set 3 | 60 marks

Leckie & Leckie Higher Administration Course Notes
Suggested solutions to Practice task set 3, Lockwood’s Business College



